Mangrove carbon estimator and monitoring guide
Mangrove carbon estimator and monitoring guide

Jeremy S. Broadhead, Jacob J. Bukoski and Nikolai (Nick) Beresnev

Published by
FOOD AND AGRICULTURE ORGANIZATION OF THE UNITED NATIONS
Regional Office for Asia and the Pacific
INTERNATIONAL UNION FOR CONSERVATION OF NATURE (IUCN)
Bangkok, 2016
Contents

Table of figures........................................................................................................iv
Preface.......................................................................................................................... v
1 Introduction.................................................................................................................. 1
2 Project area mapping .............................................................................................. 4
3 Biomass and soil carbon stock estimation ............................................................ 12
   3.1 Biomass carbon stock model ........................................................................... 12
   3.2 Soil organic carbon stock model .................................................................... 14
   3.3 Measurement procedure ................................................................................ 16
4 Mangrove monitoring ............................................................................................. 23
   4.1 Photo point monitoring .................................................................................. 23
   4.2 Satellite image analysis ................................................................................... 31
   4.3 Mangrove patrolling ....................................................................................... 37
   4.4 Physical monitoring of recently restored mangrove sites............................ 37
   4.5 Producing a monitoring report ....................................................................... 38
References.................................................................................................................. 40
Annex 1 – Carbon stock model parameters ............................................................. 42
Annex 2 – Locating plots for carbon measurements ............................................. 45
# Table of figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>QGIS start screen</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Enabling QGIS OpenLayers Plugin</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>Google Satellite layer in QGIS</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>Locating a mangrove site of interest in QGIS</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>Creating a shapefile layer in QGIS</td>
<td>8</td>
</tr>
<tr>
<td>6</td>
<td>Adding polygons in QGIS</td>
<td>9</td>
</tr>
<tr>
<td>7</td>
<td>Adjusting visualization of polygons in QGIS</td>
<td>9</td>
</tr>
<tr>
<td>8</td>
<td>Visualising different strata in QGIS</td>
<td>10</td>
</tr>
<tr>
<td>9</td>
<td>Basal area angle gauge (left) and measuring with a basal area angle gauge (right)</td>
<td>19</td>
</tr>
<tr>
<td>10</td>
<td>Basal area prism</td>
<td>20</td>
</tr>
<tr>
<td>11</td>
<td>Measuring with a basal area prism</td>
<td>20</td>
</tr>
<tr>
<td>12</td>
<td>Sample photo point map</td>
<td>26</td>
</tr>
<tr>
<td>13</td>
<td>Project site description template</td>
<td>27</td>
</tr>
<tr>
<td>14</td>
<td>Photo point description template</td>
<td>27</td>
</tr>
<tr>
<td>15</td>
<td>Sample photograph with a photo identification board and a meter board</td>
<td>29</td>
</tr>
<tr>
<td>16</td>
<td>Photo point monitoring template</td>
<td>30</td>
</tr>
<tr>
<td>17</td>
<td>Global Forest Watch Interactive Map homepage</td>
<td>32</td>
</tr>
<tr>
<td>18</td>
<td>Location of GFW Interactive Map ‘Analyze and Subscribe’ and ‘View high-res imagery’ tabs</td>
<td>34</td>
</tr>
<tr>
<td>19</td>
<td>High-resolution image of mapped-out mangrove stands, Samut Sakhon Province, Thailand.</td>
<td>35</td>
</tr>
<tr>
<td>20</td>
<td>Location of ‘Share’ and ‘Hide Windows’ icons, GFW Interactive Map</td>
<td>36</td>
</tr>
<tr>
<td>21</td>
<td>Allocation of random sampling plots in QGIS</td>
<td>45</td>
</tr>
<tr>
<td>22</td>
<td>Visualising randomly generated sampling plots in QGIS</td>
<td>46</td>
</tr>
<tr>
<td>23</td>
<td>Accessing sampling point coordinates in QGIS</td>
<td>47</td>
</tr>
</tbody>
</table>
Preface

Mangroves provide an array of benefits to coastal communities, including wood and non-wood forest products and environmental services encompassing coastal hazard protection, erosion control, water filtration and bio-diversity conservation. Mangroves are also valuable in terms of climate change mitigation due to high rates of primary productivity and the large amounts of carbon contained in above- and below-ground biomass and mangrove soils.

In spite of their many values, mangroves in Asia continue to be converted to other land uses and sustainable financing for their protection has not been forthcoming. This has resulted from limited length project cycles, lack of established Payment for Ecosystem Service (PES) schemes covering mangroves, unclear tenure in many mangrove areas, and the limited size of mangrove areas in relation to the economies of scale necessary to offset costs associated with accessing carbon payments.

This publication was prepared for the ‘Income for coastal communities for mangrove protection’ project (2015-2016) which aimed to develop a low-cost mechanism enabling public and private entities to responsibly promote mangrove conservation, carbon emissions reduction and sustainable development through the provision of incentives to local communities. The project was funded by the Swedish International Development Cooperation Agency (SIDA) through the International Union for Conservation of Nature (IUCN) and within the framework of the Mangroves for the Future (MFF) initiative. The project was implemented by the FAO Regional Office for Asia and the Pacific (RAP) in partnership with the USAID Lowering Emissions in Asia’s Forests (USAID LEAF) Programme and UN-REDD. Pilot activities and information collection took place in Pakistan, Thailand and Viet Nam.

This is the third in a series of four publications intended to be used in conjunction in establishing sustainable financing for mangrove protection in Asia. The titles of the four publications are as follows:

1. Financing for mangrove protection;
2. Mangrove-related policy and institutional frameworks in Pakistan, Thailand and Viet Nam;
3. Mangrove carbon estimator and monitoring guide;
4. Incentive allocation for mangrove protection.
1 Introduction

Mangroves exist in the inter-tidal zone of sheltered tropical and subtropical coasts, and in Southeast Asia are home to 42 tree and shrub species found nowhere else (Giesen et al. 2006). These ‘true mangrove species’ and other associate species are adapted to marine and brackish conditions, and are capable of sequestering and storing large amounts of atmospheric carbon dioxide. Mangrove soils also store large quantities of carbon as a result of tidal inundation which creates oxygen-deficient conditions that limit microbial turnover of organic material. Although the dynamics of carbon cycling in the various pools (soil organic matter, above-ground biomass, below-ground biomass and litter/woody debris) are not fully understood, the importance of halting mangrove destruction to reduce greenhouse gas emissions is well established (Donato et al. 2011).

Mechanisms which seek to create economic value for ecosystem services offer a means by which mangrove protection can be financed. While standard protocols exist to accurately measure mangrove carbon stocks, implementation is technically, logistically and financially demanding due to access and mobility problems associated with soft soils, tidal inundation and complex above-ground root systems (Kauffman and Donato 2012). The morphologies of some mangrove tree species also complicate biomass measurement and professionals are therefore usually needed to obtain mangrove carbon stock estimates. Additionally, mangrove areas in Asia are generally not extensive and economies of scale can rarely be realized to reduce per unit area costs in developing forest carbon projects (Broadhead 2011).

Given their value in terms of climate change mitigation and adaptation, mangrove protection is increasingly seen as an integral part of sustainable development. Mechanisms that can facilitate flows of results-based payments but without excessive implementation and transaction costs – including those associated with monitoring and measurement – provide a potential means by which protection of mangroves can be incentivized and up-scaled.

To help achieve this goal, this guide outlines a simple, low-cost methodology for measuring mangrove carbon stocks and monitoring mangroves in defined project areas. The guide is divided into three sections:

1. Project area mapping;
2. Carbon stock estimation; and
3. Mangrove monitoring.

A summary of each of these sections is provided below.
Project area mapping

Project area boundary mapping provides the foundation for carbon stock estimation and mangrove monitoring. Within the mapped area, points are located at which measurements are made to estimate carbon stocks and photo point locations are also recorded. The mapping method provided here entails a perimeter walk around the project area with a handheld Global Positioning System (GPS), and the use of open-source QGIS software to locate sampling points. The digitized boundary also provides a means by which multiple parties can visually assess changes in mangrove cover and land use using Global Forest Watch Interactive Map feature.

Carbon stock estimation

Past attempts to estimate mangrove biomass stocks have focused on factors that affect forest productivity such as salinity, latitude, and climatic variables (Cintron et al. 1978; Twilley et al. 1992; Hutchinson 2014). Most models are global in scope and based on variables that can be obtained without field measurements. However, these models lack precision at local scales. More recently, remote sensing capability for estimating mangrove cover and extent has increased but extensive ground-truthing remains necessary for precise estimation of local biomass and carbon stocks (Kuenzer et al. 2011).

The methods detailed here bridge the gap between intensive field-based measurement, global models and remote sensing techniques by deriving carbon stock estimates from two parameters: plot latitude and standing mean basal area. The models provide estimates of:

1. Total biomass carbon, inclusive of above-ground and below-ground stocks, and
2. Soil organic carbon.

This guide outlines the biomass and soil carbon models, and describes procedures for gathering information on the variables used in the models. A full description of the models is provided by Bukoski et al. (2016).

Although carbon is the focus of the models, carbon stock is closely related to biomass and provides an indication of the health of mangroves and the level of coastal protection which the mangroves offer (Forbes and Broadhead 2008). Carbon estimates hence deliver information on multiple mangrove values relevant to sustainable development and of interest to entities financing mangrove protection.

1 ‘Standing mean basal area’ is the total cross-sectional area of tree stems measured at breast height (1.37 meters above the ground) per unit land area, i.e. m² per hectare.
Mangrove monitoring

The objective of mangrove monitoring is to assess changes in mangrove cover and/or extent. Observed changes provide the basis for decisions and interventions by parties involved in managing the mangrove area. The monitoring methodology outlined here combines photo point monitoring with analysis of high-resolution satellite imagery to obtain information on the area, height, density and condition of mangrove stands. In addition, physical field monitoring is conducted at recently restored mangrove sites to assess survival rates of seedlings.
2 Project area mapping

This section provides a step-by-step guide to creating a digitized map of the mangrove project area boundary. This project area boundary map is used to randomly determine the location of sample plots for measurements to estimate biomass and soil carbon (Section 3), and is also uploaded to Global Forest Watch Interactive Map for monitoring purposes (Section 4.2). A layer containing the locations of points used during point photography is also added to facilitate cross-checking between monitoring methods.

The mapping process includes the use of open-source QGIS software (version 2.14 Essen), which is available for multiple operating systems and can be downloaded for free at the QGIS website (QGIS 2016a). The official guide to QGIS (QGIS 2016b) and a number of free tutorials can be found online. The steps provided below outline the mapping process.

**Step 1: Install and launch QGIS**

Visit the QGIS website and download, install and launch the QGIS software\(^2\) following the online instructions for your operating system (QGIS 2016c). You should see the screen shown in Figure 1 or similar.

![Figure 1. QGIS start screen](source.png)

Source: QGIS version 2.14

**Step 2: Enable the QGIS OpenLayers Plugin**

After opening QGIS, **OpenLayers Plugin** needs to be enabled to locate sampling plots and determine the boundaries of forest stands.\(^3\)

---

\(^2\) Guidance in this publication is based on use of QGIS version 2.14 Essen.

\(^3\)
To enable the OpenLayers Plugin, click on Plugins at the top of the screen and select Manage and install plugins... The Plugin manager will connect to the internet and then open a window showing a list of available plugins. Type OpenLayers Plugin into the Search bar at the top of the window and the plugin should appear, as shown in the screenshot below (Figure 2).

![OpenLayers Plugin](image)

**Figure 2. Enabling QGIS OpenLayers Plugin**
Source: QGIS version 2.14

Select Install plugin at the bottom right of the screen and the plugin should install. Close the window to return to QGIS's main window.

**Step 3: Load satellite imagery**

Select the Web dropdown menu from the top of the QGIS main window, and navigate to OpenLayers Plugin → Google Maps → Google Satellite. Select Google Satellite.

The Google Satellite imagery should now be loaded into the main window of QGIS, as shown in Figure 3 below. If the imagery is not immediately visible, try zooming using a mouse wheel or the magnifying glass icon.

3 ‘Sampling plots’ are plots where measurements will be taken to estimate the carbon stock of the mangrove area.
**Step 4: Locate the site of interest**

Locate the site of interest and zoom in using the above-mentioned zoom tools, as well as the pan tool (white glove icon). To zoom in more precisely, select the zoom tool (magnifying glass icon) and click and drag a square around the site of interest. QGIS will optimize the view window to that region. The area shown in the screenshot below (Figure 4) is Pak Panang in the Gulf of Thailand.
Step 5. Conduct perimeter walk to create a boundary file

Although satellite images or accurate maps of the project area can be used to create polygons defining the project area directly in QGIS, a perimeter walk with a handheld Global Positioning System (GPS) unit or a smartphone with a GPS app\(^4\) will be necessary to obtain more accurate maps of project areas. The perimeter walk serves to delineate the project area and to define different stands/sampling strata\(^5\) (see Section 3.3, Step 1). A perimeter walk also allows close physical observation and can be used to reinforce local ownership of the mangrove monitoring process.

To conduct a perimeter walk, use the “tracking” function of the GPS to map the project area boundary or the boundaries of the chosen individual strata. Upload the track/s to a computer following the GPS manufacturer’s guidance and save the file/s in GPS Exchange Format (.gpx). Next, upload the .gpx file to QGIS by navigating to Vector → GPS → GPS Tools → Load GPX file, locate the appropriate file/s, uncheck the Waypoints and Routes boxes, and click OK. The boundary/ies should appear as a new layer.

QGIS digitizing tools may then be used to create polygons delineating the project area and strata by tracing the GPS track. If a perimeter walk has not been carried out, the same technique can be used by following recognised features on the Google satellite image. A mixture of both techniques can be used if the perimeter walk excluded inaccessible areas that can nonetheless be identified in satellite images. Whichever method is chosen, a layer to save the polygons can be created by navigating to Layer → Create Layer → New Shapefile Layer (see screen capture in Figure 5 below).

In the dialogue box that opens, select Polygon as the type of shapefile layer and select the Coordinate Reference System (CRS) as EPSG:3857 “WGS 84 / Pseudo Mercator” then name the New field (e.g. “Proj_area”). Click OK and enter a name for the file when prompted (e.g. “Polygons.shp”). Save the file and the new shapefile layer should now be visible in the Layers Panel on the left side of the screen.

\(^4\) An example of a GPS app is ‘Solocator - GPS Field Camera’ (Google Play 2016a).
\(^5\) ‘Strata’ are separate relatively homogenous areas of mangroves into which the overall area is divided to reduce the number of plots that need to be sampled. Examples of different strata include newly regenerating mangroves, areas planted at approximately the same time, or areas where different mangrove species or forest type of dominate (e.g. plantation vs. primary vs. secondary forest).
Figure 5. Creating a shapefile layer in QGIS
Source: QGIS version 2.14

Note: All layer files for one GIS project should be kept in a single designated folder because each layer corresponds to five separate file types, all of which must be present for the system to work.

Before going further, save the overall QGIS exercise by navigating to Project → Save and naming the project “Mangrove map”.

Step 6. Create area boundary and sampling strata

Select the “Polygons” layer in the Layers Panel and click on the Toggle Editing button on the top left of the screen (pencil icon, shown in Figure 6 below).

To add polygons to the map, select the Add feature button (two buttons to the right of the Toggle Editing button) and carefully click around the borders of the stratum to be delineated following either the GPS track or features on the Google satellite image. When finished, right-click to stop editing and when prompted, enter the number of the stratum as the ID (e.g. “1” for the first stratum). Click on the Toggle Editing button and Save changes. Click again on the Toggle Editing button, select the Add feature and repeat as above until all strata have been delineated and corresponding ID numbers have been added. The polygons should be visible, as illustrated in Figure 6 below.
To adjust the visualization where several strata have been specified, select the “Polygons” layer in the Layers Panel, then select Layer from the top menu and then Properties, and navigate to the Style tab. In the dropdown menu at the very top, select Categorized and then click Classify (see Figure 7 below). The Layer transparency slider can be used to make the polygons semi-translucent. Click OK and the various strata should be displayed in semi-translucent, distinct colours, as shown in Figure 8 below.
Step 7. Area and perimeter calculation

To determine the area of each of the polygons, the shapefiles need to be reprojected into a CRS that maintains units of meters, as follows:

- **North_Pole_Lambert_Azimuthal_Equal_Area EPSG: 102017** for the Northern hemisphere, or
- **South_Pole_Lambert_Azimuthal_Equal_Area EPSG: 102020** for the Southern hemisphere.

The Lambert equal area projections will distort the visualization of the map, but will ensure the units of area are maintained for the hemisphere.

To redefine the geometry coordinates of a layer in QGIS, it must be saved as a new layer. Right-click on the “Polygons” layer, and select **Save as...** Set the **Format** to **ESRI Shapefile**. Using the **Browse** function, provide a new name for the layer (e.g., “reprojected_polygons.shp”) and specify a folder to store the file. Click **Save** and then select the appropriate CRS by clicking on the **Select CRS** icon to the right of the CRS dropdown list. Use the EPSG code given above to search for the appropriate CRS in the **Filter** box. Click on the named CRS in the **Coordinate Reference Systems of the world** window, click **OK** and then click **OK** again in the **Save vector layer as...** dialogue box. A new layer should appear in the **Layers Panel**.

To determine the area of each of the polygons, navigate to **Vector → Geometry tools → Export/Add geometry columns**. Select **reprojected_polygons** as the **Input vector layer** and **Layer CRS** in the **Calculate using** box. Click the box **Save to new shapefile**, and then click **Browse**. Choose a file name (e.g. “project area”)

---

**Figure 8. Visualising different strata in QGIS**

Source: QGIS version 2.14
and a folder to store the file. Click **Save** and then click the **Add result to canvas** box. Click **OK**, and a layer called “**project area**” should appear in the **Layers Panel**. Click **Close** and then right-click on the **project area** layer and select **Open Attribute Table**. The area of each polygon should be shown in square metres.⁶

**Step 8. Save area boundary for use in Global Forest Watch**

To use the project area boundary/strata boundaries for monitoring in Global Forest Watch (see Section 4.2), right-click on the “**Polygons**” layer in the **Layers Panel** and then click **Save as...** Select **GeoJSON** in the **Format** box at the top of the dialogue box, name the file (e.g. “**Mangrove_area**”) and a folder to store the file and click **OK**. Use this file for satellite image analysis.⁷

Finally, save changes to the “**Mangrove map**” project by clicking on the **disk icon** at the top-left section of the screen. Then close and exit QGIS.

---

⁶ Note: The equal area projections does not guarantee accurate distances, and thus the perimeter estimations given by the Add geometry columns method should not be used. An accurate perimeter estimation can be obtained by repeating the workflow, but for an equal distance rather than equal area projection. Any area or perimeter estimates obtained through QGIS should also be double-checked using the Area Calculator tool provided by FreeMapTools (2016).

⁷ A screenshot of QGIS showing the Google Satellite image and project boundary should also be included (together with details of the Mangrove_area GeoJSON file and its availability) in an Annex to the project agreement, as outlined in the companion publication “Incentive allocation for mangrove protection.”
3 Biomass and soil carbon stock estimation

This section of the report outlines a methodology for deriving mangrove biomass and soil carbon stock estimates using two parameters: plot latitude and standing mean basal area. The two models detailed estimate 1) biomass carbon stocks in metric tonnes (Mt) per hectare, and 2) soil organic carbon in milligrams per cubic centimeter. Estimates from the soil model can be combined with soil depth measurements and added to biomass carbon stock estimates to yield site-wide carbon stock estimates. As basal area cannot be easily measured in stands of mangrove seedlings or smaller saplings, the biomass carbon estimation methodology is only applicable to more mature mangrove stands.

The models are based on published biomass and soil carbon data, as well as associated parameters that are specific to each model (Bukoski et al. 2016). To account for spatial grouping and correlation of data taken from individual geographically focused studies, multiple-linear regression models8 with mixed effects are used (Dormann et al. 2007). In making predictions, the fixed effects parameters9 are always used, while the random effects parameters10 are applied in areas in which field measurements of carbon stock were collected.

Sections 3.1 and 3.2 provide overviews of the biomass and soil carbon stock models and their predictor variables.11 Section 3.3 provides guidance on procedures to obtain the predictor variables for each of the models.

3.1 Biomass carbon stock model

The biomass carbon stock model is based on data from studies in which measurements of stem diameter at breast height were converted to dry-weight biomass (and subsequently carbon) using allometric equations.12

The model predicts metric tonnes of total biomass carbon per hectare (Mt C/ha), including both above- and below-ground pools, from two predictor variables: basal area and latitude. The model also uses a variable calculated by multiplying these two variables together.

---

8 ‘Multiple linear regression’ is a line-fitting procedure using more than one predictor variable.
9 ‘Fixed effects parameters’ are predictor variables, e.g. basal area that apply in all cases in a non-random way.
10 ‘Random effects parameters’ are predictor variables that explain site-specific differences in carbon stock that are not associated with the fixed effects parameters.
11 A predictor variable is used to predict the quantity of carbon in the biomass and/or soil.
12 Allometric equations link measurements of one parameter to those of another e.g. tree diameter at breast height to tree biomass.
3.1.1 Predictor variable: latitude

The data collected to parameterize the model showed that mangrove carbon stocks vary with distance from the equator, most likely because of climate-related differences in morphology and net primary productivity (Giesen et al., 2007). To predict biomass carbon stocks, the latitude of the site is therefore required and can be obtained from a GPS, Google Maps or paper maps. Latitude should be specified as the absolute value of decimal degree units (e.g., 4.65 deg.).

3.1.2 Predictor variable: standing mean basal area

Basal area is the total cross-sectional area of tree stems measured at breast height per unit land area (i.e. m² per hectare). Basal area accounts for variation in the number of stems in mangrove stands as well as their size, and should be measured following guidance provided in Section 3.3.

3.1.3 Predictor variable: latitude - standing mean basal area interaction

The data collected to parameterize the model showed that, for a given basal area, the amount of biomass carbon was less at higher latitudes, suggesting that the trees were proportionally shorter. This latitudinal variation in tree form is accounted for in the model by using a variable calculated by multiplying latitude by standing mean basal area.

3.1.4 Fixed effects and mixed effects models

To predict metric tonnes of total biomass carbon per hectare, the fixed effects model uses the fixed effects parameters: 1) an intercept value and slope parameters for basal area, and 2) the basal area–latitude interaction, which is simply basal area multiplied by latitude (see Box 1). The mixed effects model uses the same parameters as well as site-related “random effects” parameters. As noted above, the “fixed effects” parameters are always used while the “random effects” parameters are applied in areas from which data were taken in parameterizing the model (see Annex 1).

In terms of accuracy, the root-mean-square-error\(^13\) for the fixed effects model is ±37.7 Mt C/ha (28.2%) and for the mixed effects model it is ±24.6 Mt C/ha (18.4%). The mean biomass carbon stock calculated from the data used to parameterize the model was 133.8 Mt C/ha.

\(^{13}\) ‘Root-mean-square-error’ is a measure of how close the model predictions are to the actual carbon stock. The predicted mean will be within the root-mean-square-error bounds on approximately 68% of occasions.
Box 1. Biomass carbon stock model

**Fixed effects only:**

Biomass carbon = $\beta_0 + \beta_1 \times \text{Basal area} + \beta_2 \times (\text{Basal area} \times \text{Latitude})$

**Mixed effects:**

Biomass carbon = $\beta_0 + \beta_1 \times \text{Basal area} + \beta_2 \times (\text{Basal area} \times \text{Latitude}) + \beta_3$

where the model coefficients are as follows:

- $\beta_0$ - fixed-effects intercept (see Annex 1, Table 1)
- $\beta_1$ - mean standing basal area parameter (see Annex 1, Table 1)
- $\beta_2$ - basal area – latitude interaction parameter (see Annex 1, Table 1)
- $\beta_3$ - random effect site intercept (see Annex 1, Table 2)

3.2 Soil organic carbon stock model

The soil organic carbon stock model predicts soil organic carbon density in milligrams per cubic centimeter (mg C/cm$^3$) from logarithmic transformations of latitude and basal area. The model is based on published empirical measurements of percent organic carbon and soil bulk density.$^{14}$

Estimates of soil organic carbon stocks in metric tonnes per hectare are obtained by multiplying soil organic carbon density estimates by soil depth in centimeters and then multiplying by 0.1 as follows:

$$\text{Mt C/ha} = \text{mg C/cm}^3 \times \text{soil depth} \times 0.1$$

Soil depth measurements should be taken at each basal area measurement plot as described in Section 3.3.

3.2.1 Predictor variable: Latitude

The relationship between soil organic carbon density and latitude found in the data collected to parameterize the model is probably linked to variation in net primary productivity with distance from the equator. The natural logarithmic transformation (i.e., base ‘e’) of latitude in absolute value of degrees from the equator is therefore included in the soil organic carbon model.

3.2.2 Predictor variable: Basal area

The natural logarithmic transformation of basal area was found to be a significant predictor of soil organic carbon density and is included in the model.

$^{14}$ Soil organic carbon density was chosen rather than soil organic carbon mass per hectare due to high levels of variation in soil depth in mangrove ecosystems.
The relationship with basal area suggests that successional stage and/or forest disturbance affects soil carbon levels.

### 3.2.3 Fixed effects and mixed effects models

To predict organic carbon density in milligrams per cubic centimeter (mg/cm³), the fixed effects model uses an intercept and slope coefficients for the logarithmic transformations of latitude and basal area (see Box 2). The mixed effects model additionally uses site-related “random effects” parameters. As noted above, the “fixed effects” parameters are always used while the “random effects” parameters are applied in areas from which data were taken in parameterizing the model (see Annex 1).

In terms of accuracy, the root-mean-square-error for the fixed effects model is 13.4 mg C/cm³ (38.6%), and for the mixed effects model it is 4.9 mg C/cm³ (18.4%). The mean soil organic carbon density from the dataset used to estimate the model parameters is 34.6 mg C/cm³.

Although the mixed effects model is considerably more accurate, it is only applicable at sites from which data were taken in parameterizing the model (see Annex 1, Table 4). To use the mixed effects model at other sites, measurement of soil carbon and re-parameterization of the model to derive site-specific random intercepts would be required. Although requiring expert inputs, this approach would be less costly and time-consuming than carrying out representative soil sampling across the whole site (see Section 3.3, Step 5).

#### Box 2. Soil organic carbon stock model

**Fixed effects only:**

\[
\text{Soil carbon} = \beta_0 + \beta_1 \times \log_e(\text{Latitude}) + \beta_2 \times \log_e(\text{Basal area})
\]

**Mixed effects:**

\[
\text{Soil carbon} = \beta_0 + \beta_1 \times \log_e(\text{Latitude}) + \beta_2 \times \log_e(\text{Basal area}) + \beta_3
\]

where the model coefficients are as follows:

- \(\beta_0\) - fixed-effects intercept (see Annex 1, Table 3)
- \(\beta_1\) - latitude parameter (see Annex 1, Table 3)
- \(\beta_2\) - basal area parameter (see Annex 1, Table 3)
- \(\beta_3\) - random effect site intercept (see Annex 1, Table 4)
3.3 Measurement procedure

To obtain the basal area and soil depth estimates as input to the biomass and soil carbon models detailed above, the following steps are necessary:

**Step 1:** Randomly identify and locate an appropriate number of sampling points within different stands/sampling strata in the mangrove area;

**Step 2:** Conduct pilot sampling;

**Step 3:** Estimate mean stand basal area; and

**Step 4:** Measure soil depth.

Two additional steps are required to complete and store the estimates:

**Step 5:** Use of site-specific intercept adjustments; and

**Step 6:** Organise and file the data.

The following sections describe these steps in detail. The measurement procedure should be repeated every five years or so to assess changes in carbon stocks associated with mangrove growth.

**Step 1: Locate sampling points**

To sample a population in a balanced way, data collection points should be randomly located. As mentioned in Section 2, mangrove areas frequently contain stands with different species composition and different structures. To adequately sample each stand type and reduce effort for a given level of precision, a stratified plot design is used. According to this method, plot locations within specified ecologically homogeneous areas (strata) are randomly assigned. In the event that the whole mangrove area is relatively homogenous, a single stratum may be used.

Strata will vary from site to site. If accurate maps are not available, it will be necessary to conduct a perimeter walk around the chosen strata using the tracking function of a handheld GPS. The tracked strata perimeters can be uploaded into QGIS and used as the basis for random generation of sampling plots within each stratum. Guidance on how to delineate strata in QGIS is provided in Section 2, while guidance on how to randomly locate sampling plots is provided in Annex 2.

The number of sampling points depends on the spatial variation in basal area, the required level of precision, and financial and time constraints. Before determining the number of sampling points, the location of a large number of points (e.g., 100 per stratum or 5 per hectare of stratum area) should be set using the procedure outlined in Annex 2. The latitude and longitude of each point should be uploaded into a handheld GPS to allow navigation to the points in the field. Most GPS manufacturers provide guidance on how to do this. If the
sampling point cannot be reached in the field, a note explaining why the point could not be sampled should be made and the next sampling point in the list should be visited.

To determine how many of the points will eventually be required to adequately sample each stratum, a simple formula is used that draws on data from pilot sampling (see Step 2 below).

First determine basal area mean and standard deviation from pilot sampling in the field (see Step 2). The sample size is then calculated as follows:

\[
\text{Sample size} = \frac{(2 \times \text{Standard Deviation})^2}{(0.05 \times \text{Mean Value})^2}
\]

This method uses a simplification that may result in some oversampling (see Kauffman and Donato, 2012). However, it is possible that additional plots will be required to achieve the desired level of precision as determined by estimating the error associated with the basal area estimate once sampling has been completed.

**Step 2: Pilot sampling**

To estimate the number of sampling points required, pilot sampling is used to determine mean basal area and the standard deviation in basal area for each stratum. One or two days should be allocated for pilot sampling across the different strata, visiting as many points as possible following the order in which they were generated for each stratum (i.e., Point 1, Point 2, Point 3, etc.). At each point, measurements of basal area and soil depth should be collected, as described in Steps 3 and 4 respectively.

After completing pilot sampling, the mean and standard deviation of the basal area values can be calculated for each stratum, and entered into the above formulas to estimate the number of sampling plots required in each strata for the desired certainty level. The pilot sampling data counts towards the final measurements of basal area, as long as the sampling points are visited in the order in which they were generated.

**Step 3: Estimate mean stand basal area**

Estimates of basal area should be obtained at each identified sampling point. Although basal area estimates may be obtained through tree diameter measurements, the point sampling method is recommended due to its ease of implementation.

Point sampling – also known as variable radius plot sampling, prism cruising, or Bitterlich sampling – is a method where trees larger than a threshold corresponding to a certain basal area are counted. To determine which trees are counted, angle gauges, prisms or smartphone apps are used (see below). Multiplying the tree tally by the Basal Area Factor (BAF) of the chosen instrument gives a basal area estimate. For example, if 13 trees are counted
using a BAF of five, the basal area estimate for that sampling point would be 65 m$^2$/ha. Lower BAFs produce more accurate estimates by including more trees but higher factors may be used in denser stands to save time.

To use point sampling, the user stands at the exact latitude and longitude of the sampling point and, using the chosen instrument, views a tree stem at a height of approximately 1.37 meters above the ground (“breast height”). If no true stem exists at 1.37 meters, as may be the case with large Rhizophora spp., the stem should be viewed at approximately 30 centimeters above the highest stilt root. A count of 1 is recorded if the stem is “included” in the plot. The next tree stem to the right (or left) is then considered and so on until a full rotation is completed. Each stem of multi-stemmed trees should be counted.

If it is not clear whether or not a stem is “in,” the diameter of the tree at breast height and the distance from the observer to the tree can be recorded along with the plot number. The diameter is then multiplied by a Plot Radius Factor\textsuperscript{15} to determine the \textit{limiting distance}, which is compared against the true distance to determine if the tree is “in”. This calculation can be done on return from the field. Simple, widely available measuring tapes can be used to measure the distance from the observer to the tree, as well as the circumference of the tree at breast height. The circumference of the tree can then be converted to diameter at a later time via the following formula:

\[
\text{Diameter} = \frac{\text{Circumference}}{\pi}
\]

Instead of measuring the diameter of the tree and comparing the distance to the tree with the limiting distance, a value of 0.5 can be recorded. However, this method will yield biased results and should be avoided if possible.

All stems are assessed, regardless of whether or not they belong to a single tree. Where distant trees are hidden behind nearby trees, a sideways step can be taken to view the stem as long as the distance between the stem and the observer is maintained. The above procedure is carried out at all sampling points. To obtain an estimate of basal area for the overall stand, estimates from all sampling points in the stratum are averaged.

As noted above, a range of instruments may be used to obtain tree counts from which basal area can be calculated, including angle gauges, prisms and smartphone apps, as described in the following sub-sections.

\textbf{Basal area angle gauge}

A basal area angle gauge has an opening with gradations corresponding to different basal area factors. The angle gauge shown in Figure 9 has three widths that correspond to basal area factors of 5, 10, and 20.

\textsuperscript{15} Basal Area Factors 5, 10, and 20 result in Plot Radius Factors of 3.89, 2.75, and 1.94 (feet inch$^{-1}$) respectively. Metric equivalents are 0.467, 0.33, and 0.233 (m cm$^{-1}$).
To measure basal area, the viewer holds the gauge upright at the length of the attached chain from his/her eye and looks through the opening at the first tree stem under consideration. If the stem fills the opening such that no light can be seen on either side, the tree is counted. If the user cannot tell whether the stem fills the opening or not, a count of 0.5 can be recorded or, for greater accuracy, the limiting distance can be calculated and compared to the actual distance, as outlined above. When using an angle gauge, the user's eye should remain directly over the plot center at all times.

![Figure 9. Basal area angle gauge (left) and measuring with a basal area angle gauge (right)](image)

Source: Courtesy of Ben Meadows® (left) and Simone Young (right).

**Note:** the pictured tree is included if using basal area factors of 5 or 10 but excluded if a basal area factor of 20 is being used. For borderline trees, assess inclusion by measuring distance to tree as described above.

**Basal area prism**

The basal area prism (illustrated in Figure 10 and Figure 11) works according to the same principle as the angle gauge. The prism distorts the object viewed such that a tree stem is counted as “in” when the section of the stem displaced by the prism overlaps with the non-distorted portion of the stem. If the distorted portion of the stem does not overlap, the tree is not added to the tally. If the user cannot tell whether the stem is in or out, inclusion can be assessed by measuring distance to the tree as described above. When using the basal area prism, the prism itself is the focus of measurement, and thus should be held above the plot center at all times (i.e. the user should rotate around the prism itself).
**Figure 10. Basal area prism**  
Source: Courtesy of Cruise-Master Prisms Incorporated.

**Figure 11. Measuring with a basal area prism**  
Source: Simone Young.

*Note:* (i) In – count, (ii) Out – do not count, (iii) Borderline – assess inclusion by measuring distance to tree as described above.

**Forest mensuration smartphone apps**

Several smartphone apps have recently become available for measuring forest structural parameters, including basal area. They are easy to access and use, and are capable of providing basal area estimates. Wide ownership of smartphones makes these apps particularly attractive although as mangroves are wet and muddy, risk of damage to smartphones should be considered. Three smartphone apps are described below. As with the basal area prism, the smartphone should be maintained at the plot center at all times.

The iBitterlich (iTunes 2016) and Bitterlich (Google Play 2016b) apps are made for iPhones and Android systems respectively, and use the phone’s built-in camera and display to show an image overlain with lines indicating boundaries against which to determine stems that are counted as “in” or “out”. The app provides buttons with which a tally can be made, including an option to count
0.5 where it is not clear whether a tree is in or out. The apps are free and instructions are provided on the manufacturer’s websites (Deskis 2016; Taakkumn 2016).

The TRESTIMA app (Google Play 2016c) is a more advanced application and has to be purchased. The app guides users in taking photos of the forest from sampling points and the photos are then sent to be analyzed by TRESTIMA. The user then receives comprehensive forest structure statistics (e.g., basal area, stems/ha, mean stem diameter at breast height, etc.).

**Step 4: Measure soil depth**

Soil depth measurements should be taken in all sampling plots and can be made with a thin sturdy pole of known length. It is best to take the soil depth measurement as close to the exact latitude and longitude of the sampling point, but before the soil surface has been disturbed. A description of a soil depth measurement technique is provided by Kauffman and Donato (2012).

**Step 5: Use of site-specific intercept adjustments**

The use of site-specific intercept adjustments will improve the precision of model estimates. If the site of interest is in close proximity to one of the sites for which an intercept adjustment exists (see Annex 1, Tables 2 and 4), a critical comparison of the ecological and socio-economic conditions at the two sites should be undertaken. If a judicious assessment shows the sites to be similar, site-specific intercepts may be used.

For the biomass carbon model, the implications of leaving out an intercept adjustment are less significant as the fixed effects components of the model are by themselves capable of predicting biomass carbon stocks with a low root-mean-square error. For the soil organic carbon model, however, the site-specific intercept adjustments greatly improve the accuracy of the model.

To use the mixed effects model at sites other than those listed in Annex 1, Table 4, users are recommended to collect soil samples and derive a site-specific intercept adjustment with expert assistance. Under such an approach, a soil core would be collected from one plot in each mangrove stratum and analyzed for bulk density (mg/cm$^3$) and percent organic carbon (%). The soil organic carbon density figures, associated basal area figures, and latitude values for the plot could then be included in re-parameterizing the soil organic carbon model to provide revised model parameters and a revised random effect intercept estimate for the site. Kauffman and Donato (2012) provide details for conducting empirical soil measurements.

---

16 See Bukoski et al. 2016 for original sources of data used in models. These sources include information on site conditions at the time of data collection.
**Step 6: Organise and file the data**

All relevant data should be saved in a spreadsheet and stored in a computer filing system. An online database should be developed (e.g. a project website, Google Drive account or similar), to allow easy access to project-related information for various users (project implementers, the project financier, government agencies, etc.). A backup archive should also be created to ensure that information is not lost if a database becomes corrupted.
4 Mangrove monitoring

The objective of mangrove monitoring is to assess change in mangrove cover or extent. The methodology described here combines photo point monitoring (Section 4.1) with visual analysis of high-resolution satellite imagery (Section 4.2) to obtain information on the area, height, density and condition of mangrove stands. Mangrove patrolling is covered in Section 4.3 and Section 4.4 outlines physical monitoring methods for use in recently restored mangrove areas. Section 4.5 provides guidance on producing a monitoring report which summarises findings from these monitoring activities.

4.1 Photo point monitoring

Photo point monitoring involves photography of a point of interest at regular intervals from the same location. The overall objective is to monitor the area, height, density and condition of mangrove stands. By providing information on stand height and a high level of detail within the areas of interest, the method complements the use of satellite imagery.

Photo point monitoring produces regular reliable information that can be shared easily to promote transparency between project partners and other parties. It also facilitates engagement of local communities in monitoring.

Photo point monitoring should commence from the beginning of the project to document the baseline situation so that project impacts can be assessed. Key steps in photo point monitoring include:

   **Step 1**: Assembling equipment;
   **Step 2**: Selecting and establishing photo points;
   **Step 3**: Photographing the scene; and
   **Step 4**: Organizing and filing information.

These steps are described in detail below. An example of photo point monitoring undertaken by WWF Pakistan is provided in Figure 12 at the end of this section.

*Step 1: Assemble equipment*

To conduct point photo monitoring, the following equipment is required:

- Digital camera, preferably with in-screen GPS coordinates;
- Camera tripod;
- GPS unit;\textsuperscript{17}
- Compass;
- Clipboard, paper, pen and clear plastic bag to use as a cover in case of rain;
- Meter board (a 1-meter plank with large markings at 10 cm intervals, attached to a pole), illustrated in Figure 15;
- Reusable photo identification board (small whiteboard and washable marker pen, or chalk board and chalk);
- Metal fence posts, steel rebars or stakes with florescent caps for marking photo points;
- Measuring tape;
- Hammer/mallet;
- Personal computer and internet connection.

The responsible individuals should possess basic GPS skills and IT skills necessary to file and distribute data.

**Step 2: Select and establish photo points**

Select photo points. A photo point is a location from which a photo is taken. When selecting photo points, it is important to identify landscape elements to be documented as indicators of achievement (or otherwise) of project objectives.

To capture changes at the forest-stand level, photos should be taken from photo points outside mangrove areas, bearing in mind that one area may be photographed from different sides for comprehensive monitoring. Ensure that enough photo points are established to inspect the whole project area and adequately document any changes.\textsuperscript{18}

Each photo point should be assigned a number and the compass bearing/s in which the photo/s will be taken should be recorded. The height of the camera should also be recorded or a fixed height used (e.g. the full height of the camera tripod used). The number of photos taken will vary according to monitoring requirements and, in some cases, several photos may be taken in different directions from the same photo point.

\textsuperscript{17} An alternative to a digital camera and a GPS unit is a smartphone with a built-in digital camera and an installed GPS app such as ‘Solocator - GPS Field Camera’ (Google Play 2016a).

\textsuperscript{18} As an example, to monitor a 1 000 ha mangrove area in Keti Bunder district, WWF Pakistan established 32 photo points (Umair Shahid [WWF-Pakistan], 2016, Pers. Comm., 1 February).
Physically mark photo points. Permanently mark photo points so they can be easily located in the future. There are various options for marking, including metal fence posts, steel rebars, or stakes with florescent caps driven into the ground with the top 5-10cm left exposed.

Record GPS coordinates of all photo points. GPS coordinates are particularly important in cases where it is impossible to physically mark a photo point (e.g. in deep water) and should be recorded for each photo point using the assigned number as the point name.

Upload GPS points to a computer for mapping. Upload the GPS points recorded at each of the photo points to a computer following the GPS manufacturer’s guidance and save the file/s in GPS Exchange Format (suggested name – “photo_points.gpx”).

Create a photo point map. Open the QGIS project created following the steps in Section 2 (“Mangrove map”). Next, upload the “photo_points.gpx” file to QGIS by navigating to Vector → GPS → GPS Tools → Load GPX file, locating the file, unchecking the Routes and Tracks boxes and clicking OK. The points should appear as dots on the background Google Satellite image.

Add the point numbers as labels by selecting the layer in the Layers Panel and navigating to Layer → Properties → Labels. At the top of the dialogue box, click on the dropdown list and select Show labels for this layer. Next click on the Label with dropdown list and select name. If the text does not show on the map, return to the Labels Panel and adjust the text colour and/or background.

To print the map or to paste into a document or spreadsheet, use the computer’s Print Screen function, open Microsoft Paint and click on Paste. Then crop the image as required and save as a JPEG picture. The image can then be imported into documents or spreadsheets by navigating to Insert → Picture and then locating and clicking on the file. A sample photo point map with added descriptions of photo points is provided in Figure 12 below.
Figure 12. Sample photo point map
Source: USDA, undated.

Record project site and photo point information in a spreadsheet. Project site information should include project location, total area, site description and photo point map (see Figure 12). Photo point information should include photo point ID numbers, GPS coordinates, compass bearing in which the photos are to be taken, and camera height. Microsoft Excel templates for recording this information are provided in Figure 13 and Figure 14 below.

Note: these templates are provided as suggestions only, and can be adjusted according to project requirements.
Step 3: Plan and prepare, then photograph the scene

Decide when to photograph. Determine the time of year, the frequency and the period over which monitoring photographs should be taken. For mangrove protection activities, photos are recommended to be taken upon commencement of the project and every six months thereafter. To monitor
seedling survival during mangrove restoration activities, photos are recommended to be taken during physical inspection visits immediately after restoration, each month for the first three months and then at three monthly intervals (see Section 4.3). If restoration proceeds well in the first two years, photo point monitoring can revert to a six-month interval.

Create photo identification board. To embed pertinent information about the site into the picture, place a photo identification board within the camera’s field of view each time a photograph is taken. The board should contain the following information:

1. Site name;
2. Date;
3. Photo point ID number;
4. Photo point compass bearing; and
5. Photographer’s initials.

Small whiteboards or chalk boards can be used as convenient reusable photo identification boards.

Photograph the scene. Take the initial photograph of the scene as follows:

1. Locate the photo point marker using a GPS and a printed copy of the photo point map;
2. Using a tripod and setting the camera at the designated height, point the field of view towards the recorded compass bearing;
3. Place the meter board and the photo identification board in front of the camera, ensuring that they do not excessively obscure the scene. Record the distance between the meter board and the photo identification board (if the photo is taken from a small boat, the meter board and the photo identification board should be at the opposite end to the camera);
4. Include one-third skyline in the photo frame to help indicate the scale of the scene being photographed (Figure 15);
5. Take the photograph and turn the camera to the next recorded compass bearing, or move to the next photo point as appropriate.

For each photograph, record a description of the scene including information about the condition of mangroves, weather and other relevant information (e.g. evidence of animal or human activity).

---

19 The meter board provides a scale reference that can be used to quantify change in mangrove height.
For subsequent photographs, repeat the points above and compare the view through the camera to the initial photograph. Adjust so the view through the camera matches the initial photograph. If possible, take photos at low tide so mangrove seedlings and roots can be seen, and avoid taking photos when visibility is poor or when the sun is in the field of view.

![Sample photograph with a photo identification board and a meter board](image.png)

**Figure 15. Sample photograph with a photo identification board and a meter board**
Source: USFS, undated.

**Step 4: Download, organise and file the information**

For referencing purposes, each photo can be saved with a name incorporating the date, photo point ID and compass bearing in a contiguous string of numbers as follows:

- **Date** – eight numerals, e.g. 20160714 for 14 July 2016
- **Photo point ID** – three numerals, e.g. 008 for point 8
- **Compass bearing** – three numerals, e.g. 090 for 90°N

The full file name for a photo using the above examples would be: 20160714-008-090. Using this system, photos can be sorted by date and photo point ID and compass bearing in a computer filing system.

The photos from each round of monitoring should be saved in a separate, easily identifiable folder within a logical filing system together with spreadsheets including site and camera information, and a copy of the photo point map (described in Step 2). Result of photo analysis (see below) can be stored in the
same system. The information should be stored in a project online database, as described in Section 3.3 to provide access to project partners and others.

**Step 5: Analyse the photos**

Photos from consecutive monitoring periods should be compared with the initial photo of the scene to assess changes in area, density and condition of mangrove stands. Any evidence of mangrove expansion, loss or degradation should be recorded. Identified changes should also be checked and verified against satellite imagery (see Section 4.2). A spreadsheet template for monitoring is provided in Figure 16 below.

![Spreadsheet template](image)

**Figure 16. Photo point monitoring template**

Source: Microsoft Excel.

An example of photo point monitoring undertaken by WWF Pakistan in the Sindh Province is provided in Box 3 below.
Box 3. Photo point monitoring of mangroves in Keti Bunder

Since 2010, WWF Pakistan has used point photography to monitor rehabilitated mangrove stands in Keti Bunder, Sindh Province. The following methodology has been applied:

1. Thirty-two points were established across the 1 000 hectare mangrove area, with each point selected on the basis of its location relative to mangrove stands.
2. Each point was marked with a concrete pillar.
3. GPS was used to record point locations, and photos were taken towards each of the four cardinal points (north, south, east and west).
4. Photos were taken annually from same points using the same camera, focal length, camera height and bearings.

Images obtained through this methodology are provided below.

Point photographs of mangrove site in Keti Bunder in May 2010 (left) and May 2012 (right).


4.2 Satellite image analysis

The recent increase in availability of satellite imagery and processed outputs, and the advent of web based remote sensing interfaces have enabled non-expert users to conduct land cover assessment with relative ease. The method described here uses the Global Forest Watch (GFW) Interactive Map, an online forest monitoring and alert system (see Figure 17). GFW uses remote sensing imagery to provide information on the status of forest landscapes worldwide,

20 Umair Shahid, North Indian Ocean Coordinator, WWF-Pakistan.
21 Global Forest Watch is a partnership between organizations contributing data, technology, funding, and expertise, including UNEP, University of Cambridge, GEF, USAID and CGIAR, among many others. The partnership is convened by the World Resources Institute.
including near-real-time alerts of tree cover loss in defined locations. It is free to use and enables users to create custom maps, analyse forest trends, receive alerts, or download data for a defined area or the entire world.

Figure 17. Global Forest Watch Interactive Map homepage.
Source: Global Forest Watch 2016.

The steps below describe the use of the GFW Interactive Map to obtain high-resolution images of the mangrove area of interest and set up forest cover change alerts. Images are analysed to assess the area, density and condition of mangrove stands, and any changes detected through photo point monitoring are cross-referenced. Automatic alerts provide an additional means of monitoring change.

Step 1: Equipment and set-up
To use GFW, the following are required:

- Personal computer, internet access and basic IT skills;
- A Gmail, Facebook or Twitter account for creating a GFW profile;
- Microsoft Paint or equivalent software for saving high-resolution images.

Step 2: Access the GFW Interactive Map
1. Go to the Global Forest Watch Interactive Map website:  
   http://www.globalforestwatch.org/map
2. Select Skip the walk through when the dialogue box appears.
Step 3: Upload a project area boundary map onto GFW Interactive Map website

The GFW Analyze and Subscribe function allows users to upload an area boundary delineated by GPS or draw the area they want to analyse. The Draw or Upload Shape function allows the user to upload the mangrove area boundary created in Section 2, Step 5 (suggested filename: “Polygons.shp”).

1. Turn on the forest change data layer you want to receive alerts for. Relevant forest change data layers that can be subscribed to are summarised in the table below. Read more about each dataset by clicking on the green “i” next to each dataset in the menu;

<table>
<thead>
<tr>
<th>Forest change data layer</th>
<th>Function</th>
<th>Geographic coverage</th>
<th>Update frequency</th>
<th>Resolution (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree cover loss</td>
<td>Identifies areas of gross tree cover loss</td>
<td>Global</td>
<td>Annual</td>
<td>30</td>
</tr>
<tr>
<td>GLAD alerts</td>
<td>Identifies areas of likely tree cover loss in near-real time</td>
<td>Brazil, Peru, Kalimantan, Rep. Congo, Uganda, Russian Far East. Will expand to humid tropics.</td>
<td>Weekly</td>
<td>30</td>
</tr>
<tr>
<td>Terra-i alerts</td>
<td>Detects areas where tree cover loss is likely to have recently occurred</td>
<td>Tropics</td>
<td>Monthly</td>
<td>250</td>
</tr>
</tbody>
</table>

2. Click on Analyze and Subscribe (see Figure 18 for location of the icon);
3. Click on DRAW OR UPLOAD SHAPE;
4. Click on CLICK TO PICK UP A FILE OR DROP ONE HERE;
5. Upload the file containing the project area map (GeoJSON file named ‘Mangrove_area’ suggested in Section 2, Step 8). The recommended maximum file size for uploading is 1MB, and many file formats are supported.22

22 Supported unzipped files: .csv, .json, .geojson, .kml, .kmz (.csv files must contain a geom column that contains geographic information). Supported zipped files: .shp (zipped shapefiles must include .shp, .shx, .dbf, and .prj files). Only polygon data is supported (not point-and-line data). Learn more about accepted file formats by clicking on the green “i” icon next to the CLICK TO PICK UP A FILE OR DROP ONE HERE option.
Step 4. Create a GFW profile

Creating a free GFW profile allows the user to save their areas online and to subscribe to GFW alerts of changes in the selected areas.

- Having uploaded the project area map, scroll down the Analyse and Subscribe window and click on SUBSCRIBE;
- Create a GFW profile by logging in with your Gmail, Facebook or Twitter account, and filling in the required information (name, email, sector, etc.).
- Subscribe to alerts on annual tree cover loss data in your project area by entering your email address and clicking NEXT.\(^{23}\)
- Name your subscription, e.g. Project area map and click SAVE.
- Click RETURN TO MAP.

Step 5: Access high-resolution images of the project area

Within the Interactive Map, UrtheCast platform provides high-resolution satellite imagery from a variety of sensors (THEIA, Landsat 8 and DEIMOS-1 at the time of publication). These images are updated at intervals of between three

\(^{23}\) Alerts consist of regular (daily to monthly, depending on the dataset) updates on tree cover change in the selected area, and notifications if new forest change data is available. The user is alerted via emails sent by GFW to their registered email account. Because automated calculations of tree cover changes are not 100% accurate, the information contained in the alert should be verified by analysing high-resolution images of project areas (Step 7).
days and one-two times per month (depending on the sensor), and can be viewed at any time. It is recommended that images are saved at six-month intervals, to coincide with photo point monitoring.

- From the Interactive Map homepage, click on the **MY GFW** icon at the top of the screen;
- Click on **MY SUBSCRIPTIONS**;
- Locate the saved subscription (e.g. “**Project area map**”) and click **VIEW ON MAP** (small globe icon);
- Click **VIEW HIGH-RES IMAGERY** (see Figure 18 for the location of the icon);
- Select **UrtheCast** to use all available sensors or click on **OPEN ADVANCED SETTING** to select a specific sensor;
- Choose the latest available acquired date. The high-resolution image should now be available to view. Click on an image to see the capture date and sensor name. The most recent image for an area is shown, though the date range can be modified in the menu.

A sample image of 10-hectare mangrove areas in Thailand’s Samut Sakhon province is provided in Figure 19 below.

![Sample Image of Mangrove Areas](image-url)

**Figure 19.** High-resolution image of mapped-out mangrove stands, Samut Sakhon Province, Thailand.
Source: Global Forest Watch 2016.
Note: The satellite basemap in GFW is from Google. Although it may be of higher resolution than the imagery available under the UrtheCast, details of the basemap are not made available except that it is between one and three years old. Higher resolution imagery comparable to that seen in the Google satellite basemap may be added to GFW in the future and filtering by date would be possible (Barrett, 2015, Pers. Comm., 2 September).

Step 6: Share and save high-resolution images

To share the image of the project area:

- From the Interactive Map homepage, click on the SHARE (S) icon (see Figure 20 for the location of the icon).
- Click on LINK, and then COPY. This copies a link to the high-resolution image, which can be pasted into an email and shared with project partners.

To save the image of the project area:

- From the Interactive Map homepage, click HIDE WINDOWS (see Figure 20 for icon location). This will remove non-essential windows from the screen, allowing you to clearly capture the image.
- Press Print Screen on your computer keyboard to take a screenshot.
- Open Microsoft Paint and click Paste in the top right corner.
- Save the image as a JPEG picture in a computer filing system such as described in Section 4.1, Step 4. The image can then be imported into documents or spreadsheets by navigating to Insert → Picture and then locating and clicking on the file.

Figure 20. Location of ‘Share’ and ‘Hide Windows’ icons, GFW Interactive Map
Source: Global Forest Watch 2016.
**Step 7: Analyse high-resolution images**

The analysis of high-resolution images should focus on the changes in area, density and condition of mangrove stands. The most recent image should be compared to the image saved six months prior, and any evidence of mangrove expansion, loss or degradation should be recorded. Identified changes should also be verified against changes recorded during point photography (described in Section 4.1).

### 4.3 Mangrove patrolling

Regular patrolling of mangrove areas to prevent and detect encroachment should be undertaken by appointed community members. Incidents of encroachment by local people or animals should be addressed by the community, while illegal encroachment by outside interests should be reported to local authorities. All instances of encroachment should be recorded and included in mangrove monitoring reports.

### 4.4 Physical monitoring of recently restored mangrove sites

Whether mangrove seedlings are planted, or restoration takes place through Ecological Mangrove Restoration (MAP 2016) or natural regeneration, monitoring is important in providing information upon which to base further management interventions. Survival rates of seedlings vary due to site and weather conditions, planting techniques and encroachment (among other factors). The survival rates of seedlings cannot usually be accurately assessed using point photography alone or satellite imagery due to their small size; consequently, physical inspections are necessary.

It is recommended that physical inspections are conducted every month for the first three months after planting, and then every three months for two years. After two years, physical inspections can be conducted concurrently with six-month point photography visits (see Section 4.1, Step 3).

Physical monitoring is conducted by counting the number of seedlings surviving in temporary plots within the restored area. This can be done by counting the number of live and dead seedlings adjacent to fixed, randomly selected points within the restored area. The points can be marked with canes with high visibility tape attached. To formalise the process, one person can stand by the cane holding the end of a 5.6 metre length of string, while another holds the string at its full extent and walks slowly in a circle recording the number of live and dead seedlings as the string passes over. The area surveyed will be close to 100 square metres and five such circular sample plots per hectare will provide a 5% sampling rate.

To augment the count, the average height of living seedlings can be recorded. Notes should also be made about seedling condition and likely causes of death.
of seedlings that have not survived. Record all information in a spreadsheet and store it in a computer filing system described in Section 4.1, Step 4.

4.5 Producing a monitoring report

A monitoring report should be produced every six months, summarising information gathered during point photography, satellite image analysis, patrolling and physical monitoring. It should contain photographs and satellite images to illustrate changes in the mangrove stands or to confirm that no changes have taken place. The report should also highlight new developments since the previous reporting period, including:

- progress in solving issues identified in the previous report; and
- new issues and how they might be addressed.

The report should be stored in a project online database and made available to the financier and other project partners. The report should contain the following information:

**Project area map (produced at the start of the project, with updates as necessary):**

1. Dates of field work;
2. Names of responsible persons;
3. GPS tracks of project area/sampling strata in GPX format;
4. GeoJSON file including project area/sampling strata polygons, suggested name: “Mangrove_area”.

**Biomass and carbon stock estimation (conducted at the start of the project, with updates as necessary and at least every five years):**

1. Dates of fieldwork;
2. Names of responsible persons;
3. Sample size calculations;
4. Coordinates of plots sampled in all strata;
5. Basal Area Factor of sampling instrument used;
6. Tree counts for each sampled plot;
7. Soil depth measurements for each plot;
8. Biomass and soil carbon estimates and calculations including information on use of fixed effects or mixed effects models.
Photo point monitoring (conducted at the start of the project, and then at six-month intervals):

1. Project location, total area, site description;
2. Photo point map (showing project area, strata and photo point locations);
3. Photo point information (ID numbers, coordinates, photo point bearings and camera height);
4. Point photos and analysis.

Satellite image analysis (conducted at the start of the project, and then at six-month intervals):

1. High-resolution image/s of project site shared from Global Forest Watch, saved as a JPEG file;
2. Information on changes detected during analysis of high-resolution images.

Physical monitoring of recently restored mangrove sites (monthly for three months then every three months up to two years then six monthly)

1. Counts of live and dead seedlings;
2. Analysis of seedling condition or probably cause of death;
3. Point photos.
References


FreeMapTools. 2016. Area calculator. URL: [https://www.freemaptools.com/area-calculator.htm](https://www.freemaptools.com/area-calculator.htm)


QGIS. 2016a. Homepage. URL: http://www.qgis.org/en/site/

QGIS. 2016b. QGIS User Guide. URL: http://docs.qgis.org/2.8/en/docs/user_manual/


## Annex 1 – Carbon stock model parameters

### Table 1. Biomass carbon model fixed effects coefficients.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Coefficient</th>
<th>Standard Error</th>
<th>Degrees of Freedom</th>
<th>P-Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>$\beta_0$</td>
<td>-8.43</td>
<td>3.32</td>
<td>118</td>
</tr>
<tr>
<td>Basal Area</td>
<td>$\beta_1$</td>
<td>5.76</td>
<td>0.10</td>
<td>118</td>
</tr>
<tr>
<td>Basal Area × Latitude</td>
<td>$\beta_2$</td>
<td>-0.13</td>
<td>0.01</td>
<td>118</td>
</tr>
</tbody>
</table>

### Table 2. Random effect intercept estimates ($\beta_3$) for sites included in parameterizing the biomass carbon model.

<table>
<thead>
<tr>
<th>Country</th>
<th>Site</th>
<th>Intercept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>Dampier</td>
<td>6.6</td>
</tr>
<tr>
<td>Australia</td>
<td>Port Hedland</td>
<td>2.0</td>
</tr>
<tr>
<td>Australia</td>
<td>Bay of Rest</td>
<td>12.3</td>
</tr>
<tr>
<td>Australia</td>
<td>Mangrove Bay</td>
<td>-4.1</td>
</tr>
<tr>
<td>China</td>
<td>Futian Nature Reserve</td>
<td>12.1</td>
</tr>
<tr>
<td>China</td>
<td>Leizhou Bay</td>
<td>-5.6</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Kumai, Borneo</td>
<td>1.7</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Manado, Sulawesi</td>
<td>-21.6</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Bintuni</td>
<td>14.0</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Bunaken</td>
<td>22.3</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Kubu Raya</td>
<td>14.8</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Sembilang</td>
<td>27.8</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Tanjung Puting</td>
<td>-9.0</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Teminabuan</td>
<td>6.6</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Timika</td>
<td>13.6</td>
</tr>
<tr>
<td>Japan</td>
<td>Manko Wetland</td>
<td>7.0</td>
</tr>
<tr>
<td>Malaysia</td>
<td>Matang Mangrove Forest Reserve</td>
<td>-10.2</td>
</tr>
<tr>
<td>Malaysia</td>
<td>Kuala Selangor</td>
<td>3.5</td>
</tr>
<tr>
<td>Malaysia</td>
<td>Sungai Haji Dorani</td>
<td>11.9</td>
</tr>
<tr>
<td>F. S. of Micronesia</td>
<td>Kosrae</td>
<td>-2.5</td>
</tr>
<tr>
<td>F. S. of Micronesia</td>
<td>Yap</td>
<td>-3.1</td>
</tr>
<tr>
<td>Myanmar</td>
<td>Bogale</td>
<td>2.1</td>
</tr>
<tr>
<td>Thailand</td>
<td>Krabi River Estuary</td>
<td>-17.6</td>
</tr>
<tr>
<td>Thailand</td>
<td>Pak Panang, Nakorn Si Thammarat</td>
<td>-4.2</td>
</tr>
<tr>
<td>Thailand</td>
<td>Kamphuan River, Ranong</td>
<td>4.9</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Hai Phong</td>
<td>-0.2</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Quang Ninh</td>
<td>13.9</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Mui Ca Mau Biosphere Reserve</td>
<td>31.5</td>
</tr>
</tbody>
</table>
Table 3. Soil organic carbon model fixed effects coefficients.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Coefficient</th>
<th>Standard Error</th>
<th>Degrees of Freedom</th>
<th>P-Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>$\beta_0$</td>
<td>38.62</td>
<td>7</td>
<td>73</td>
</tr>
<tr>
<td>$\log_e$(Latitude)</td>
<td>$\beta_1$</td>
<td>-11.31</td>
<td>2.31</td>
<td>73</td>
</tr>
<tr>
<td>$\log_e$(Basal area)</td>
<td>$\beta_2$</td>
<td>4.48</td>
<td>1.45</td>
<td>73</td>
</tr>
</tbody>
</table>

Table 4. Random effect intercept estimates ($\beta_3$) for sites included in the parameterization of the soil organic carbon model.

<table>
<thead>
<tr>
<th>Country</th>
<th>Site</th>
<th>Intercept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>Bay of Rest</td>
<td>11.1</td>
</tr>
<tr>
<td>Australia</td>
<td>Dampier</td>
<td>11.5</td>
</tr>
<tr>
<td>Australia</td>
<td>Mangrove Bay</td>
<td>17.0</td>
</tr>
<tr>
<td>Australia</td>
<td>Port Hedland</td>
<td>6.1</td>
</tr>
<tr>
<td>F. S. of Micronesia</td>
<td>Kosrae</td>
<td>4.7</td>
</tr>
<tr>
<td>F. S. of Micronesia</td>
<td>Yap</td>
<td>13.7</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Bintuni, West Papua</td>
<td>-3.3</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Bunaken</td>
<td>21.3</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Kubu Raya</td>
<td>-11.0</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Kumai, S. Borneo</td>
<td>-12.4</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Sembilang</td>
<td>3.6</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Manado, Sulawesi</td>
<td>19.3</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Tanjung Putting</td>
<td>-11.0</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Teminabuan</td>
<td>-5.8</td>
</tr>
<tr>
<td>Indonesia</td>
<td>Timika</td>
<td>11.4</td>
</tr>
<tr>
<td>Japan</td>
<td>Manko Wetland</td>
<td>-6.3</td>
</tr>
<tr>
<td>Thailand</td>
<td>Krabi River Estuary</td>
<td>-9.4</td>
</tr>
<tr>
<td>Thailand</td>
<td>Pak Panang</td>
<td>-15.7</td>
</tr>
<tr>
<td>Vietnam</td>
<td>An Bien</td>
<td>-8.0</td>
</tr>
<tr>
<td>Vietnam</td>
<td>An Minh</td>
<td>-9.9</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Can Gio Biosphere Reserve</td>
<td>1.5</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Hai Phong</td>
<td>-7.6</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>------</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Mui Ca Mau</td>
<td>-10.9</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Kien Luong</td>
<td>-6.6</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Kien Vang</td>
<td>3.1</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Quang Ninh</td>
<td>2.7</td>
</tr>
<tr>
<td>Vietnam</td>
<td>Vam Rang</td>
<td>-9.1</td>
</tr>
</tbody>
</table>
Annex 2 – Locating plots for carbon measurements

This annex provides guidance on randomly locating sampling plots, and extracting plot coordinates using QGIS. It follows directly from the steps to develop a project area map, described in Section 2.

**Step 1. Randomly locate sampling plots**

QGIS’s **Random Points** tool is used to locate sampling plots within each stratum. Select **Vector → Research Tools → Random Points** to open the tool. In the dialog box, select the **reprojected_polygons** layer (see Section 2, Step 7) as the **Input Boundary Layer**, then under **Stratified Sampling Design (Individual polygons)** select 100 in the **Use this number of points** box (see Figure 21). Click **Browse** and choose a name for the output shapefile (e.g. “Random Points”) and store it in the same folder as other layers. Click **Save**, select **Add result to canvas** and click **OK** then **Close**. A **Random points** layer will appear in the **Layers panel**. Right-click on the layer, select **Set Layer CRS**, and adjust the CRS to:

- **North_Pole_Lambert_Azimuthal_Equal_Area EPSG: 102017** for the Northern hemisphere, or
- **South_Pole_Lambert_Azimuthal_Equal_Area EPSG: 102020** for the Southern hemisphere.

Right-click again on the layer and select **Zoom to Layer**, and the points should now overlay the strata polygons as shown in Figure 22.

![Figure 21. Allocation of random sampling plots in QGIS](source: QGIS version 2.14)
Step 2. Save latitude and longitude coordinates of points for GPS use

To use the sampling points in a GPS, they must be reprojected to WGS-84 reference system so the coordinates are in decimal degrees. Right-click the Random points layer, select Save As... and save the layer in GPS eXchange Format [GPX] with a CRS of EPSG:4326 “WGS-84”. Click Browse and choose a name for the file (e.g. “Sampling points GPX”) and store it in the same folder as other layers. Click Save and then OK. In the dialog box that appears, select the waypoints layer and click OK. A layer called Sampling points GPX waypoints any should appear in the Layers Panel. The GPX file can be uploaded to a GPS following the manufacturer’s instructions and used to locate the plots.

Note: It is important to use the sampling points in the order generated rather than visiting points grouped in one area. The number of points actually used will depend on calculations based on pilot sampling (Section 3.3, Step 2) and should easily be less than 100 per stratum. Left-over points can be discarded.

Step 3. Access the sampling point coordinates

To obtain the coordinates of the sampling points, right click on the Random points layer select Save As... and then select CSV format and a CRS of EPSG:4326 “WGS-84”. Click Browse and include a file name (e.g. “Sampling points coordinates”) and folder location before clicking Save and OK. To view the sampling point coordinates, right-click on the Sampling points coordinates layer in the Layers Panel and select Open Attribute Table. The coordinates (X = Longitude, Y = Latitude) will now be visible, as illustrated in Figure 23. The CSV file can then be opened via external spreadsheet software and used to provide an easily accessible record of the plot coordinates.
Table showing sampling point coordinates in QGIS.

Source: QGIS version 2.14

---

**Figure 23. Accessing sampling point coordinates in QGIS**

Source: QGIS version 2.14
Mangroves provide a wide array of benefits to coastal communities, including wood and non-wood forest products and a wide range of environmental services encompassing coastal hazard protection, erosion control, water filtration and bio-diversity conservation. Mangroves are also valuable in terms of climate change mitigation due to high rates of primary productivity and the large amounts of carbon contained within above- and below-ground biomass and mangrove soils. In spite of their many values, mangrove areas continue to diminish in size around Asia and sustainable financing for their protection has not been forthcoming.

This publication was prepared for ‘Income for coastal communities for mangrove protection’ project (2015-2016) which sought to develop a low cost mechanism enabling investors to responsibly promote mangrove conservation, carbon emissions reduction and sustainable development through the provision of funding to local communities.

This is the third in a series of four publications intended to be used in conjunction in establishing sustainable financing for mangrove protection in Asia. The titles of the four publications are as follows:

1. Financing for mangrove protection with emphasis on Pakistan, Thailand and Viet Nam
2. Mangrove-related policy and institutional frameworks in Pakistan, Thailand and Viet Nam
3. Mangrove carbon estimator and monitoring guide
4. Incentive allocation for mangrove protection